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          Abstract: 
 

During the last academic year, our school's Astronomy Group focused its research on 
the exploraƟon and study of space, its stellar objects and phenomena that take 
place out there.  As part of the so-called D-SPACE project, in collaboraƟon with few 
other educaƟonal insƟtuƟons of our country, we decided, in cooperaƟon with the 
Skinakas Observatory and the University of Crete, to request to acquire pictures of 
certain stellar objects, visible during the summer period. 
 
The ediƟng of space photographs is considered to be one of the most controversial 
issues, with many conspiracy theorists calling it an act of propaganda by the major 
space companies to present a fake image of space rather than the real one. 
ParƟcularly, this issue came to a climax over the past year following the release of 
the photos by NASA's James Webb Space Telescope (JWST) and the reacƟons that 
ensued over the "vividness" of their colors. Following my personal extensive 
research and, in accordance with the opinion of the majority of the scienƟfic 
community, I aƩempt through this research to logically refute the aforemenƟoned 
argument and highlight the benefits of processing space images, taking also into 
consideraƟon my own personal experience of processing the Skinakas images. 
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SECTION 1 
 
IntroducƟon: 

Major space companies such as Nasa employ a large number of expert technicians 
who are solely responsible for the meƟculous and accurate processing of astral 

telescope images and their conversion into imagery that can actually be perceived by 
the human brain. (Admin, 2023) 

 

Why are telescope images processed? 

 
1. Telescope images are captured in the grayscale (monochromaƟc). (Ward-Bailey, 
2015). This is because these sensors only record photons; not their color. In addiƟon, 
such black and white sensors uƟlize the full possible light in the environment, unlike 
''color'' sensors, which repeat the process for each filter (red, green, blue). 
Therefore, the black and white image is much sharper than the color image. 
 
However, it should be noted that the human eye has difficulty in disƟnguishing all 
shades of grey. Consequently, it becomes difficult to grasp all the visual details of the 
stellar object based on the single-color photograph. (Cheddar, 2019, YouTube). 
 
2. The sensors that take pictures in space do not usually uƟlise light visible to us, but 
UV (ultraviolet radiaƟon) or infrared light that must be carefully converted-
translated into the spectrum we can actually see (Frąckiewiczin, 2023). 
 
3. When we study complex shots (i.e. galaxies) some elements of the object emit 
waves outside the visible spectrum, so they are not perceived by the human eye. 
Through processing and using appropriate detectors, technicians can highlight and 
add bright colors to these spots to render them visible (SuƩer, 2016). 
 
4. Each hue of color in a stellar image carries an important role as it indicates specific 
chemical elements that comprise the basic composiƟon of both the universe and its 
phenomena. Different elements also emit varying lengths of light, thus acquiring a 
different colour that disƟnguishes them from others (Cheddar,2019, YouTube): 
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Figure 1: The correspondences between the colors of a star image and the chemical 
elements they represent 

Oxygen 

 

 

Hydrogen 

Example 1: Each color represents one chemical element 



 
 
 

"I basically take raw grayscale data from different parts of the infrared spectrum, and 
then remap them into visible colors, to create images that are accurately 

representative of the infrared colors that human eyes cannot see" CalTech's Robert 
Hurt highlights and points out: 

 

    "I think of it as a visual translation process." (Hurt, 2015)  

 
 

Through the digital processing of the images, a map depicƟng the universe is 
simultaneously developing. The human eye is characterised by lots of weaknesses 
that can be overcome by digital ediƟng. (SuƩer, 2016) 
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Example 2: Mapping the universe in relaƟon to its chemical elements 



 
 
 

Furthermore, it essenƟal to be menƟoned that there are two types of space photo 
ediƟng: 
 

 The one done with the use of amateur digital programs, aiming at the aestheƟc 
improvement of the image, but not necessarily the scienƟfic depicƟon and its 
accuracy- flawlessly. 
 

 The processing with a view to the best possible illustraƟon of the astral objects for 
the facilitaƟon of the scienƟfic study and the comprehension of the observed 
object. 

Generally, it is the second method which predominates. As Paul SuƩer, an 
astrophysicist in the University of Ohio has emphasised: ‘’The image’s processing is 
90% for the benefit of science and 10% for the benefit of the public’’.  
(ShuƩer, 2019) 

 

 

Major Space Companies make available the raw data to the public, so that the 
scienƟsts around the world take advantage of the opportunity to conduct their 
own research into the accuracy of the observaƟons. In this way, a collaboraƟve  
environment is enhanced and the will for more scienƟfic research is fostered. 

(Admin, 2023) 

 
 
SECTION 2 
 
Skinakas image processing   
 
1. Telescope shots 

 
Based on the Celestron Messier Catalogue, as a team, we iniƟally selected the 
objects based on visual aƩracƟveness. We also made sure that these objects were 
situated high on the horizon during the summer season and that the Moon was 
located relaƟvely far away to avoid being affected by its shadow and light, so that we 
could secure opƟmal condiƟons for the best and sharpest images. We thus chose the 
following: 
 

 A Globular Star Cluster (NGC 6934) 
 Two Spiral Galaxies (NGC 7331 and NGC6946) 

Note 



 
 
 

 The remnants of the explosion of a supernova (SNR) 
(what we call nebula – NGC 6992) 

 
2. Skinakas Telescope CapabiliƟes  

 
It is worth knowing the telescope’s technical characterisƟcs in order to compare the 
same object image taken by different telescopes. It has what is known as a Focal 
Reducer, which more than doubles the field of view of the telescope, which is 
parƟcularly important for photographing objects that cover a wide field. In addiƟon, 
it is equipped with an Autoguider system and finally it features a set of opƟcal filters 
(Risse, 2006), (Wikipedia, 2023). The camera used is near-infrared; that is, it uses the 
radiaƟon emiƩed by a wide range of sources, mainly cold stars (which are usually 
those with small masses). Low-mass stars are the most prevalent in space, which is 
very convenient for near-infrared star photography. The telescope is located at a high 
alƟtude (Mount Ida, PsiloriƟs) in order to avoid the high levels of city light polluƟon, 
which greatly affect our exposures. (Retrieved from the official website of the 
Skinakas Observatory) 
 
(Retrieved from the official webpage of the Skinakas Observatory) 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
The images sent directly from Skinakas, without technical processing, (as menƟoned 
in the previous secƟon) were black and white and therefore difficult to analyse. In  
fact, each object is not clear individually, as it is faint in the shot.  
 
 

  Picture 1: The Observatory at Skinakas 

 



 
 
 

 
 
 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

Picture 3: The shot of the first spiral galaxy  
taken by the telescope (NGC 7331)  

Picture 2: The shot of the Globular Cluster 
taken by the telescope (NGC 6934) 

Picture 4: The shot of the second spiral galaxy 
taken by the telescope (NGC 6946) 

Picture 5: The shot of the supernova star’s  
remnants taken by the telescope 

(NGC 6992) 



 
 
 

Since the features that provide informaƟon about each object are unclear (which is 
not convenient for data analysis), I commenced the procedure of processing each 
shot in each filter (red, green, blue) and their final merge in RGB. 
 

3. RGB color model 

As is well known, color as we perceive it does not exist. In other words, there is no 
property of the object called color. 

What we scienƟfically call "color" is a limited part of the spectrum of 
electromagneƟc radiaƟon. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Light is actually a range of frequencies. When light strikes an object, the object 
absorbs some of the frequencies, and reflects the rest. For instance, a yellow object 
is one that absorbs all but those in the yellow spectrum. (Trantzas, 2016) 

 
 

 

Table 1: The visible light spectrum  
 



 
 
 

So, when these frequencies are received by the human eye, specific brain cells are 
affected and interpret each frequency as a unique colour. It therefore follows that 
colour is subjective and each human brain perceives it differently. 

Thus, there arose the need for standardisation of colors, so that each colour 
corresponds to a mathematical value. In this way, the final form of the image results 
in a set of pixels, each consisting of different combination of colors. (Trantzas, 2016) 

The technique used in modern photography is to take three different shots of the 
same image with different filters. Each filter allows only light of specific 
wavelengths to pass through, which match a particular color. In the end we get 
three pictures (all in the grayscale, but each containing information about a specific 
wavelength). Afterwards, they are automatically combined together and we get the 
color version of the image. (Jäger, 2021) 

 
 
 
 
 

 

 

 

Example 3: Colors in video capture  

 

 



 
 
 

In a similar way, the telescope observes each stellar object for: 

5 minutes using the first filter (red), 5 minutes using the second one (green) and 5 
minutes using the third one (blue).  

We should note that photos are greyscale again (see section one); however, for 
example, using the blue filter, the photo will only contain information about the 
blue photons. (Jäger, 2021) 

We technically have the capability to assign colors to the object manually and 
subsequently mix the three, different shots in one, called the RGB version. At the 
end of the procedure, we get the detailed, colored version of the observed object.  
(Smith, 2015) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Example 4: The wheel of a telescope’s filters 

 

 



 
 
 

4. Methodology used for the Skinakas photo processing 
 

The program I uƟlised for the photo ediƟng was ‘’SalsaJ’’; it is a rather simple digital 
program, ideal mainly for students, which simultaneously indicates the procedure 
that the professional astronomers follow to edit astral photos. So, the steps I took 
were straighƞorward as follows: 
 

i. Firstly, I ran ‘’SalsaJ’’ 
 

 

 

 

 

 

 

 

 

 

ii. Then, I selected File >Open, to gain access to the telescope imagery. 
 
 

 

 

 

 

 

 

 

 

 
 
 

Step 2 

Step 1 



 
 
 

iii. I placed each picture next to other by selecƟng Window>Tile. 
 

 

 

 

 

 

 

 

 

 

 

iv. AŌerwards, I selected Image>Type>32-bit in order for the pictures to 
be rendered in the best possible way in terms of color. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

v. AŌer that, I matched each photo to its color selecƟng to Image > 
Lookup Tables.  
 

Step 3 

Step 4 



 
 
 

 
 
R⬌Red 
V⬌Green 
B⬌Blue 

 
 
 
 
 

 
 

 

 

 
 

vi. Then, I adjusted brightness and contrast for each image selecƟng 
Image>Adjust>Brightness/Contrast up unƟl each and every detail in 
every colored secƟon could be disƟnguished, based on shots of the 
same object, taken by other telescopes, so as to achieve the most 
detailed result.  

 

 

 

 

 

 

 

 

 

 

 

vii. Finally in order for me to create the final colored picture, I selected 
Image>Color> RGB Merge, matching each photo to its corresponding 
colored filter. 

Step 5 

Step 6 



 
 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 

 

Example 5: The mix of the remnants of a supernova star’s 
shots (using the three filters) in RGB  

 

Result 

Step 7 



 
 
 

SECTION 4 

1. Results  

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 

NGC 6934 is situated in the constellaƟon of Delphinus and is 52 kilolight-years from 
the Sun. It exhibits a wide range of photometric anomalies. (Wikipedia, 2023) 

 

Picture 6: The result of the Globular Cluster shot (NGC 6934) 
 

Note 



 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

NGC 7331 is about 45 million light-year from Earth and it is placed in the 
constellaƟon of Pegasus. It appears to have a plethora of similariƟes with the Milky 
Way in terms of structure and size. In fact, there is a tendency to call it ‘’the Milky 
Way’s twin’’. It is one of the brightest galaxies and emits X-rays and radio waves. 

(Wikipedia, 2023) 

Picture 7: The result of the first spiral  
galaxy shot (NGC 7331) 

Note 



 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

NGC 6946 is located between the constellaƟons of Cepheus and Cygnus, 
approximately 25 million light-years from Earth. Due to its disƟncƟve shape and 
because in it have been observed ten supernovae, it is also called Fireworks Galaxy. 
(Wikipedia, 2023) 

Picture 8: The result of the second spiral  
galaxy shot (NGC 6946) 

Note 



 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The shot does not depict the enƟre nebula owing to the fact that telescopes are not 
capable of observing such a wide field. The supernova source is esƟmated to have 
been a star 20 Ɵmes more massive than the Sun, which emiƩed energy and light so 
powerful that it surpassed Venus in bright and it was visible even during the 
dayƟme on Earth. Probably, it exploded from 10.0000 to 20.000 years ago. 
(Wikipedia, 2023) 

Picture 9: The result of the supernova remnants shot 
 (NGC 6992) 

 

 

Note 



 
 
 

2. EvaluaƟon 

 
To conclude, we would say that the difference between the iniƟal captures and the 
results is considerable on the grounds that essenƟally the photo became plus 
beauƟful aestheƟcally, while at the same Ɵme the color display we are able to 
derive a variety of informaƟon such as : 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Example 6: The informaƟon that we receive about the 
chemical elements that make up each astral object   

 
Oxygen 

Double ionised  
oxygen 

Oxygen 



 
 
 

Furthermore, special reference should be made to this strange, blue ''line'', 
which can be noƟced in the photo with the remnants of a supernova. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Picture 10: The satellite footprint in the shot  
of the supernova remnants (NGC 6992) 

 

 



 
 
 

While the telescope was observing the object using the blue filter, a satellite was 
near the supernova remnants and its route is recorded as the bold, blue line in the 
picture above.  

Even taking into consideraƟon the above example, we noƟce that everything in an 
astral photo is meaningful. Nothing is fake and pointless to exist.  

Plus, not only does a space image reveal data for one astral object, but the 
telescope is also, not so well every Ɵme, capable of providing informaƟon about 
other galaxies or stars depicted in the picture.  
 
ParƟcularly, in telescopes of a high accuracy (e.g James Webb and Hubble), this can 
be done in great detail, indeed (Ward-Bailey, 2015). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Example 7: The other stellar object seen 
in the galaxy NGC 7331 shot 

 

 



 
 
 

SECTION 4 

 
A. Conclusion  
 

Through this research project, the main thing that I have come to understand is that 
art and informaƟcs working together with science is of outmost importance and 
deemed a necessity. For many years there has been a percepƟon specifically 
targeƟng art, that it is not a field of science and that it is something subordinate. On 
the contrary, the main conclusion that emerges through this study is that the 
collaboraƟon of art with all fields of science and informaƟon technology can have a 
posiƟve effect on the facilitaƟon of research. AŌer all, this is why Nasa recruits a 
large number of specialists in this field to carry out the ediƟng. Yet alongside art, 
the beauty and immensity of the universe is perfectly emphasized in a unique way.  
 
Space photos may look similar to the spectacular ones on social media (in terms of 
filters and colours), but there is a fundamental difference. Astronomers use real 
data, in real Ɵme, and simply sharpen them so that they are clearly visible to the 
human eye but also enƟce people to engage and seek out more informaƟon about 
each object depicted. 
 
In our journey to explore space, we can therefore entrust without hesitaƟon the 
processed astral photographs to be a true and enchanƟng journey to the beauty, 
perfecƟon and complexity of the universe, combining the rigour and precision of 
the science of Astronomy, which is far from being forgoƩen or lost by the general 
public. 
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